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TTRPAS )Y AR B B IEAE, R Y ARBRH “Yomin” 2080, “Y-max” B0N 2, #§ “Title” BN “ i REMIEmN ", W7REas ik 7.28 Fs.



|lemloleoo hEB®E &

ime offset. 0

B 7.28 mEBRER

(1) RS fE 1 (Integrator) 1 2 A s A ERL (zero-pole) ER G, [ i5tf# ] “Math Operations ” #EELZE FR ] “ Gain ™ AR BRAL B SUR PR IO 18 25 8- 10
(2) HEREAEYL, T “Gain” BLHERWIA A, RUILFHEMA “Flip Block” BB

(3) WEMISH, ¥ “zero-pole” BB HOHFHET I “Zeros” #2500 “[1” » ¥ “Poles” £2HHN[-0.6].

¥ “Gain” B “Gain” ZHECN-1. HBRATE 7.29 PR,

[ T o]
s (=+05)

r

Stept Integrater Fero-Fale Scopel
-1 |=
Fain
B 7.29 —BrRGRE

UK I 28 e A Sinks 7 BEHRZE 1 € Out” REHR (0 Outl s SR J5 747 HL S 05 B IEHE N “ Workspace /O™ TU(TAE S [ A4 ), K “Time ” F1 “Output’
FEA M, H43 790 ¥ B ARATAE A 23 (] i () g AR B “tout” AT “yout” o 4 B JA A6 LAEAS [k v] M X AN A8 sk 2l 2k, il 7.30 Fios:
plot(tout,yout)
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Bt EAC mew jeiT Tk ARdee pep
haEHE " AAr BERD

B 7.30  plot Sl FXIRHgw PR T

(B 7.4) #flE0 MBS HORTT, BEst GO AESLIATT, Hph—ME RN, REFA TN T ER RS, ARG S.

IR AERL I 3L

(1) EFE— “Step” b, LA “Transfer Fen” FHL, EFEFD “Sum” B, EFEFHA “Scope” ML, EFE— “Gain” L, 7F “Discrete”
HeFE ik $E—A> “Discrete  Filter ” fll—/™ “Zero-Order Hold ” &k,

(2) AL, W RBIA “Gain” BEHURI “Zero-Order Hold ” HEHEH%: .

(3) WEZH, “DiscreteFilter” 1 “Zero-Order Hold” i) “Sample time” #F13 E N 0.1s.

(4) WISCARERE, REERWE 7.31 Fis.

—
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ity &0 [y g9 a1 E ) 1 wte [

= 1-z-1 LRS! ol
ep T=0.1 0.8 Scopel

v

& 7.31 BB RSER



(5) WE BT, Simulink Jy#5 B H 2 77 (10 2R ER A [FRAEAER (K3 VR G FIAE S A, 7T AR AN [F] BB R s AN R IR R 2, 1% 61 51 Format” > Sample
time color” , 7] LLF BA [FRAESE BB AN ] o
(6) FFeE1i 5, 7E Simulink M E 1, AP “Simulation” = “Simulation parameters...” , K “Max step size” B E N 0.05s, MFHANRPEE “Scope” Fl
“Scopel” AWK 7.32 Fiw.

<} Scopel : ==l Bl
lea(orpp BB DE

ime offset: 0

B} 7.32 T=Tk=0.1 (a) d(k)7 B BT () yOT BB BN
A DA HE 2 T=Tk=0.1 I R G4 i BT RS
(7) B33, ¥ “Discrete Filter ” B “ Sample time” & N 0.6s, “Zero-Order Hold ” HEff) “Sample time ” N2, MEFESEH “Edit” > “Update diagram’
B, Hinl LA F| “Discrete Filter” BLRFIEIEAAL 15 AEHGEHE, MRS ERWE 7.33 s,
A LA 4 T=0.6 1] Tk=0.1 i, RZEH IR .
(8) IBEAZ %L, ¥ “Discrete Filter” F1 “Zero-Order Hold” #iEL /] “Sample time” #13 E N 0.6s, FEHAERE G, FFEDHE, NRESERWE 7.34 Fix.

<} Scopel

|lemoeo aEB BE &

ime offset. 0

& 7.33 T=0.6 Tk=0.1 (a) d(K) PR ER



2 T=Tk=0.6 I, RGP EIIKIIRY; -

<} Scopel

|lemcer ABRB| B E &

ime offset. 0

ime offset. 0

& 7.34 T=0.6 Tk=0.1 (a) d(k)FR PR BFR ) yOFER BT

NAG DU B F SRS RS T, 7T DM A SR A R (24
U8 7.51 K [ 7.4 RO BN RRR, S5 7.35 P,

wh A0 [ o vempt

+
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Hi1
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Step Seapal

Tk
& 7.35 B REER
W S H0% B E Ex0705_1.m SO
%Ex0705 1  BHHE
T=0.1; %o | P T SR T[]
Tk=0.6; % W R FRE 2 RAF 1]

k=0.03; %Gain 38 %5



zt1=1.44;zt2=-1.26;zt3=1;zt4=-1;
tf11=6.7;t£12=0.1;tf13=1;
tf21=1;t£22=3;tf23=1

£ MATLAB TAE S [Ali8471% 301
Ex0705_1

7.6 FRHESHEK

TRGRMUT HIEE S PR TRE LT RGEA WAL AR EE T REMECH T RG] E#AL.

1. ZEBVHRATHRTRA

U8 7.61 FT7F L9 7.41 AESLAEAY, Kbt Grb i3 — MBS P R RN — A T R S

FERA T AR, R D R AP I3 — ST I SR ] bR Ha AR AHERE 1, IR HEE . “Edit” > “Create subsystem” , W RS 7.36 i

o N [
0454 a5 1

Beopail
Dutl i) g

5 b a

B7.36 FREML
Wil 7RG, W2 DL “Subsystem” BAE 1, @Il 7.37 Pros. WTLVE 2T RGAMER 7R RASEERPIAIAST, & EZhRMN 7 — M AR “In1” A1
— M AR “Outl” .

2. EEFNTFRGER FRRY

U 7.7] 75 [ 7.6] KISEmt B3 T R4, % L6 7.6 BRGNS LA S — DR ST BAMEN AT RS

B 7.36 H it A 5 SRR B0 S R E b, XGRFT I R 4SE “Subsystem” , W HBLANE 7.37 Fis BT R GRS 1, B INAARLRY S AR IE 1K
FR RS, W 7.38 Fis.



=] Ex0706 /Subsys = E

Fle Edit WView Similation

File Edit View Simuladon Format
Tools Help

71 Ex0706,/5ubsystem — 0] x|

DSEHS| 4B o RE

Format Tocls Help
DeEd&E| B0
aAs+1
?lm
<rle [
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B 737 FREEUTD
B}7.38 FRERSED
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1. fEEEF &4t (Enabled Subsystem)




Block Parameters: Cutl
Curipet

Provaicks i OUp pod ior 8 s ubsnsiem or mcdel. Tha 'Ouigel wten dissblad"
Block Parameters: Enable x| ared Tnital outpu’ pameEsns onky apphy 1 condiionaly sxsceiad subsaeme
‘Whaan a congibonally esecned wbeysem i depbled, Be ool is sither beld
— Erable Part A i bt vl ot io B niinl oupu’ The Tnital oupu? pammesr can ke
- . epesciiad as B asphy mabe [ inwhich G e the intial aupel s sgqual 1o thse
Place thiz block in a subspstem to create an enabled subsystem. auputofthe black iseding the oupon

r— Parameters

FParamsten:
States when enabling: |h3|d j Fortnumber.

|1
- P SR

¥ Enable zero crossing detection

Iniisl crsgnit

[o
Ok, I Cancel | Help | Spply |

s

I P a

[ 7.41 () “Enable” BRSHBE () “Outl” BB R
OB 7.8] %S, — R RE T &R Ge i IR 5% 15 5 9B R =5 B

B IE5%15 % “Sine wave” NHINGE SR, REEE “Scope” NELUHLER, fHEET R4t “Enabled Subsystem” A% il ik,
TEPREL, ¥4 “Sine wave” BIHRHIHIH/EA “Enabled Subsystem” HIiZEHIE 5, AWK 7.42(a)f 7.

THafTE, T “Enabled Subsystem” HI#EHINIELE S, KTERPATHL, NTERFFILE, MORBEEEREERERE S, R ERaE 7.42(b)
Btz o

2. i RTF RS (Triggered Subsystem)
B 7.9) 57—+ R Guds il IE 5245 5 % Hh B T IR 2 2

Fulse
Generator

,E} ] ! Out1

L g
Sine Wave
Triggered Scope
Subsystem
Sine ave

B 743 () MRTFRGEA

A 7.42 (a) fEREFRGEE ) RERER



A IE5Z(5 5 “Sine wave” NHIANG SR, RIS “Scope” NEIEEL, ik T R4 “Triggered Subsystem” JNEHIHEEL, EFE “Sources” ML 1]
“Pulse Generator” BRI HE 5.

ERAREY, ¥ “Pulse Generator” FEIHR[%IH/E N “Triggered Subsystem” HI#E {55, ALK 7.43@)F~.

a1 E, BT “Triggered Subsystem” [J4ZHiI°4 “Pulse Generator” B4, 7~y asdrH W&l 7.43b)Fs.

3. {HEEMR T R4E (Enabled and Triggered Subsystem)
R R T RGO iR T RAFNERE T RAMA S, SAHMKESIERE SR EHIE SR, iR F4 K4 S, Simulink B &M HE 52 B AT 0,
KT 0 BIFLEHAT -

1. HETFRENIHR

(D) &P FREXNGETIF, HHEHTMERNSEIRE M EESY:

(2) &P “BEdit” > “Mask subsystem” , I X TEHE;

(3) HEHBEXFAEF IR ESE, FEAH “Icon” . “Parameters” . “Initialization” I “Documentation” PU/NMIEITR .

2. IconEWE
Tcon I~ F T 150 B R 1 2 RSN, anl&] 7.44 Fioso

-} Mask editor Selysten Ba =10] =]

[ | Paramaters | Initiatzation | Documergston |

Ie-on nptions Dirawing commands
Frame ol
i-.-'.;.hlé -
TrareEparer 1
Flel i Lifras amd dloijeas)
E':p_r_lug‘ dinp ichow Bamt in csnber of Black]
baxt lxkow Saxt ai w lesmiian)
Ralation
=F|m|1 LERge Ixhow m picturs on the block)
patsh i Eilled shapea)
Units cabar [ohargge dramamg oeler) =
laptgscale |dreatas [xkow zara peola) P
dpely Ughiw Sransfer Punation)
EMMOESE forintf  (print formaibed bast)
(SRR T oy i, 1abel abel spacific perns)
oF
Bwia poe_kaleiloutput, 1, 0

Urimask (e 4 J Cancel | Help | Apphy
B} 7.44 Icon BEH R

(1) Drawing commands £~



Rk H P A EbR, nTUERbR R BRSO, B BB % K355 . 7E Drawing commands #5144 & H “Examples of drawing commands”
R HFR 7R, B plot. disp. text. port label. image. patch. color. droots. dploy Al fprintf.

(2) Icon Options =

F T 9 B AR A

3. Parameters 0
Parameters 110~ H T 5 N4 & A FAAE B 387, aniEl 7.45 Fios.

-} Mask editor Subsysten

=0/ x|

Iton  Paramelers | Initiakzation | Documerdsion |

Dilzion para meters
ﬂ F'roempl variabie | i Tunable
x| : .
-
ﬂ poEup

Cpons for selecled parameter

Popups (ore per bne). Inidialog: M Show parameter ~ Enable parameter

-

Urimask [0 24 | Cancel | Help | Apphy |
B 7.45 Parameters SR

(1) Add\ Delete\ Move up *D Move down ﬁ?%ﬂ

MTam. Mg, BRI BmALE.
(2) Dialog Parameters
. Prompt: fIAZRERE L, HARSRRERMARRY,
. Variable: i A& ZFK.
. type: A ISR AL TR X (k. “Bdit” $EHE—ANGRAEHE; “ Checkbox” $2HE—ANFIEHE; “Popup” $&MHE—ANiH AR,
. Evaluate: HTALA “type” MIAFRNEDHR AR EE, AMWAIED “Evaluate” F1 “Literal”, H & X5k 7.6 fis.

$2.7.6 Assignment FEIRAF X

Evaluate




Edit BNKISC T RAEFHATR TR R | R AR A B 747 8

Checkbox WmE 1o it oy on Y off
Popup BB RS EASE, H—N 1 | KRB ELE TR P

(3) Options for selected parameter
Pops: 4 “type” i&Ft “Popup” W, FFH N NHiEHIi,
Callback: F T4 A [a] 1 B 4o

4. Initialization Mk
Initialization &I FH T HIGH LI 25T R 4.

5. Documentation &I F

Documentation IR F 79 5 5 1% 5 BP0 1) Help MIELRASCT, 7305l “Mask type” « “Mask Description” #l1 “Mask help” 1.
(1) Mask type ¥

T B R R B R

(2) Mask Description *

T ARR STAR

(3) Mask help #*

T4 N R BISOA .

6. &4l
BEZHBEMIEHETN “Apply” $HI M TR B BN B3 “Unmask” 240 A TR BB, DO BB A 2 L€ 1 R0 G AE .

(B 7.10] QUi B RS IR T REGHTEE.
QIEE— A I RS R T R, HEEH IR R zeta FIEHLEHIR wn (E MRS
(1) BB, IR REMILE REIER: zeta F07, TMEHA LR wn #5, W 7.46 .
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File Edit %ew 3Simulation Format Tools Help

DIB”E%I%E|9Q|> llNormaI 'H

~=1of x|

uty ert) wnAz wit) [
s2+ 2 zatatng -

Scopel

Step

Reac [100% [ [ |odeds v

B 7.46 B RGRA
(2) FHHRERAEEAE S IR, MRS H “Edit” > “Create Subsystem” , W=7 24, K 7.47 Fis.

=10l x|

File Edit Yiew Simulation Format Tools Help

D|D”ﬂ§|¥:ﬁ|9@|b llNormaI 'H

E P In Out . (I

Step

Scoped

Subsystem

Reac [100% [ [ Jodeds Y

147 FTRABRE

() HIET RS, EFEEH “Bdit” > “Mask subsystem” , HILEZEXTIEHE, ¥t zeta A wn E NI SEL.
7E Tcon TR B E H “Drawing commands” £ 5 7 mEMZE, G4 UWT:

disp( —BrREt"

plot([0 1 2 3 10],-exp(-[0 1 2 3 10]))

1F Parameters YR, Huili “Add” EHZATMPAMA S, WE “Prompt” 4514 “FLIE R Rl “TRLRIRSHR 7, FHUE “type” £ 51 “Popup’
N “edit” , XN “Variable” N “zeta” Al “wn” , W& “Popups” N “00.30.50.70712” , 4l 7.48(a)fT 7w
1E Initialization eI RATGEHFIASEL, WK 7.48(b)FT 7.
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pan  Paramalan | Infaision | Documeniaion | kan | Poeamaters  iisizeion | porumenision |

Dialag para=eners oo vawiaales Irfszation o
Pazmipl Wari ah by i E Tun shks Rize] vt aml TOT

o -
HHEEEME Wi =k ;l | W

L+ L 3¢ &

Dl e aleclid para ik
Poguss (e per e In @6y W Show pecamaiern M Esasie gaamiter

oar =
uremask o | canat | we | sew | urmask | o | canen | new | sew
& 7.48 (a) Parameters %I F (b) Initialization EWF

7£ Documentation 3& I 4 NS~ A BIE B, W 7.48(c)FTw.

J Mask ediltor Subsysbem =10] =}

kon I Paramsiars Infiakzabion Cocumentation |

- Mask bpe
|ml35hEuD&r5-tE'"r'

Mask descnpdon

hig ig @ continuag sysiam
salacizelaform 0020507071 3,
ripulwr

~ Mask help

[This I hedgn of MyMaskSubsystam
pami 0

Ursnask I QK i Cancel I Help I Apphy I

& 7.48(c) Documentation JETHE

iy “OK” #%Hl, TMSHRE, RENEZERT RS, WHIWE 749 RMEET RS, WE1ZT R HIE 7.490)F7m RN\ SEHEHE, 18
MHEHEFHIAN “BLIERE” zeta M1 “EFLEIRGMR" wn BIME, FATENT R IRMEE TS HB EXEE T




=l ex0710 * -0l x| Block Parameters: Subsystem #
File Edit WYew Simulation Format Tools Help — Myt azk Subsystem [mask]
= B ) I -I Thiz iz a continues system
DFE& sB@R (2| r =tm | select zeta form 0 0.3 050,707 1 2;
input wi
IE i e p ] mEFRE [o =
Step Soapel ForE iR 03
Subsystem I_D a5
0.707
]
Reeac [100% T T [od=i5 Y oH2
B 7.49 (a) BHET RGN (b) HRTRESTHEIN\INEIE

7.7 B MATLAB #34% 68| F1151T Simulink f2#!

1. Simulink % 5304
(1) B R
new_system 7 2 HR1E MATLAB ) TAF 2% [ 6% — /N2 Y Simulink 24,
i%?i:
new_system(‘newmodel’,option) % AIERFRE
P ‘newmodel’ NAEAI4Z ; option 1T A] LA Library I’ Model’ B Fh, WA LAA RS, BERIAA Model .
(2) FTIFHER
open_system 4 FH>RFTHFBIEMAL, 7E Simulink A E MR /RIZABA
i%?i:
open_system(‘model’) %ITIFERAL
YiBH: ‘model WY 4
(3) TRAFELTY
save_system iy 2 FI SR IRAE B AYSC A, 47 84408 .mdl.
i%?i:
save_system(‘model’, 34 44) % RTRRA

YEHA: ‘model AR A AT WS, WUIRANGS AR A, W E SR AT, SCIF R TR IR SCIE 4G, 27T ds, AT g, WERANE NS I OR A7 3T SCAF

[$ 7.11] H MATLAB #5400 @ s A,



new_system("Ex0711model") Yol 32 AR Y

open_system("Ex0711model’) % T A AL
save_system("Ex0711model','Ex0711") Yo PRAFRLAL A
2. FFITBLRAVE S 4R

(1) AR

4§ add_block iy & 7EFT FF (PRI & 11 R g A o

Wk

add_block(CUsfE 4%, > HEEIRAL @S UJBMEE 1, EiEL 20 BIHE 2,..)
VLR CYRRLERAZ Oy — AN ORI R AR 4, A e AR B O e R 4%, Simulink [ A5 AR Y AERRER, 40 1E 5% 45 5 4515k 4 built-in/Sine Wave’;
H AR 44 e T T A (A 4 .

(2) WINEFE

BT MG T EERER, NG 52 add_line i7 %

Wk

add_line(C i EL AR B A4 v 15, 2 BB 44 /4 N v 11 5)
add_lineCBU45°,m)

ULEH: B ONTERE R O TR R 2 s m A AT R IR, BHI4E H— AT AR
(4 7.11 82]1 F MATLAB i 2% INPUAMBEOE B — A~ B KRG,
add_block('built-in/Step',"Ex0711/Step','position’,[20,100,40,120]) %S INBNER(S B
add_block('built-in/Sum','Ex0711/Sum','position’,[60,100,80,120])  %¥s /Il Sum Lk
add_block('built-in/Transfer Fen','Ex0711/Fcn1','position',[120,90,200,130])

YU NN 1o bR HUAT R
add_block('built-in/Scope',"Ex0711/S cope"','position',[240,100,260,120]) %7 Il I ds i e
add_line("Ex0711",'S tep/1','Sum/1") YollN NI 2%

add_line("Ex0711','Sum/1','Fcn1/1")
add_line("Ex0711','Fcn1/1','S cope/1")
add_line("Ex0711','Fcn1/1','Sum/2')

FEFF 43 HT: 'position A7 BB, BB A'Ex0711',
M H B A& 7.50 Fras s,



=
se+Zer

Step Sum Scope
Feni

B 7.50 —BrRGRA

3. RERAARIUR

(1) @V 3575
U 7.00 8] 3575 B0 8 b A & SR L 1 4 3L
fl=simget("Ex0711")

fl =
AbsTol: 'auto’ Y4 XT VR ZE R
Debug: 'off Y& 5 SR VFERER I
Decimation: 1 YA, A1 S 1K
DstWorkspace: 'current' Yol Hh LA 2]
FinalStateName: " YRS L TS
FixedStep: 'auto’ %E B
InitialState: [] Yo WU IRAS ]
InitialStep: 'auto’ % HILGHT K
MaxOrder: 5 Yot e FAZ BT IR
SaveFormat: 'Array’ %A B
MaxDataPoints: 1000 Yot NIR [B] fi Ak
MaxStep: 'auto’ Yot N
MinStep: [] V3 UGS
OutputPoints: 'all’ ok H
Output Variables: 'ty' o H AL
Refine: 1 Yo E A
RelTol: 0.0010 YorHXT iR 72
Solver: 'ode45' Yo i FLA:
SrcWorkspace: 'base’ % AN E TAESH]
Trace: " Yore g BN
ZeroCross: 'on' Ferillid 2 R

(2) wEBEMEME
(3) WEBHAIE 5 2k = 1k



OB 7.11 8] W B S ER RN, @A U] 7.31 BURSH0H M B RGEA.

set_param('Ex0711','S topTime','15") %o 1 B SR LI ]
set_param('Ex0711/Step','time",'0") %W B M k(S 5 LS E
set_param('Ex0711/Sum','Inputs','+-') %1 E Sum LS 5 FFS
set_param('Ex0711/Fcn1','Denominator','[1 0.6 0]') Yok B 15 18 PR £ o3 B

W 2 GeA RUHE B U & 7.51 Bl

: : »=
Step =240 Fis

Sum Scope
Fend

B 7.51 —BrRGsa

4. HERBURAUE S£

(1) MR

A5 ar ) 7 e s A D 4 S <
delete_block("Ex0711/Scope')

(2) MMER{E 54k

i sim 2R TE MK, E a2 T Tk v] LA (58 i 4588 5 A A B
Wk
[t,x,y]=sim(‘model’,timespan,options, ut) %R MASEGRITHE, MHiERE
[tx,y1,y2,...]=sim(‘model’ ,timespan,options,ut)%ﬁ]ﬂi BMASEHTHE, ZME
UL ‘model” WA 4 timespan & ELHS (A X (8], AJ LLZ[t0,tf] RN ARIT (A FIZE 1ERFE], AT DUR[], ARG TEHE BB ], A e brmMIFe 20tk
i ] options ZHCNBIAEHIZEG ut NAMTRIARIE. t AREIGIRIE; x ARSEEM IR y N AE S RE, S50 R — g E Y.
timespan - options I ut ZE# A] A % .
B 7.11 88]) i&47 —Fh RGBT ERMA N, 40 7.50 Fis .
[t,x.y]=sim('Ex0711',[0,15]);
plot(t,x(:,2))
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7.8 LA Simulink AEAMAER T BEfFEE N

FEFTIT Simulink I HI A A, A AT B 7.1 B Ze (0 A AR B 22 A0 T B A (Block and Toolboxes) A Hr A1 HY 7 &-&sk A 477 L3419
FERPT IR A
i1 24 T B 4H (Control System Toolbox)
JE{E A T 4 (Communications Blockset )
A5 5 A PR H T BL4H(DSP Blockset)
R PEFE HI B T B 46(NCD Blockset)
SE A ARFEALER T HL4fi(Fixed-Point Blockset)
RSV (StateFlow)
ARG R AL T ELA4H (System ID Blocks)
P I 25 HE e T H 4 (Neural Network Blockset)
R & 45 T A 46 (Fuzzy Logic Toolbox)



